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Abstract

Background: Various interacting and interdependent components comprise complex interventions. These
components create difficulty in assessing the true impact of interventions designed to improve patient-centered
outcomes. Interrupted time series (ITS) designs borrow from case-crossover designs and serve as quasi-experimental
methodology able to retrospectively assess the impact of an intervention while accounting for temporal correlation.
While ITS designs are aptly situated for studying the impacts of large-scale public health policies, existing ITS software
implement rigid ITS methodology that often assume the pre- and post-intervention phases are fully differentiated (by
a known change-point or set of time points) and do not allow for changes in both the mean functions and correlation
structure.

Results: This article describes the Robust Interrupted Time Series (RITS) toolbox, a stand-alone user-friendly
application researchers can use to implement flexible ITS models that estimate the lagged effect of an intervention on
an outcome, level and trend changes, and post-intervention changes in the correlation structure, for single and
multiple ITS. The RITS toolbox incorporates a formal test for the existence of a change in the outcome and estimates a
change-point over a set of possible change-points defined by the researcher. In settings with multiple ITS, RITS
provides a global over-all units change-point and allows for unit-specific changes in the mean functions and
correlation structures.

Conclusions: The RITS toolbox is the first piece of software that allows researchers to use flexible ITS models that test
for the existence of a change-point, estimate the change-point (if estimation is desired), and allow for changes in both
the mean functions and correlation structures at the change point. RITS does not require any knowledge of a
statistical (or otherwise) programming language, is freely available to the community, and may be downloaded and
used on a local machine to ensure data protection.
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Background
Evaluating the impact of complex interventions on
patient-centered outcomes is a critical concern in public
health, as natural experiments are generally not scientif-
ically controlled. Randomized controlled trials, the “gold
standard” for evidence-generation of health interventions,
are often infeasible and impractical regarding health care
reform [1]. As such, data from natural experiments in
public health do not typically arise from randomized con-
trolled trials [2]. According to the 2018 Annual Review
of Public Health, interrupted time series (ITS) designs are
aptly situated for studying the impacts of large-scale pub-
lic health policies [3]. ITS designs borrow from traditional
case-crossover designs and serve as quasi-experimental
methodology able to assess the impact of an intervention
retrospectively and account for temporal dependency [4].
Natural experiment data regularly present as ITS:

sequences of measurements for an outcome (e.g., patient
experience scores) recorded at various time points before
and after an intervention. Simple comparisons of the
mean pre- and post-intervention, say via a t-test, do not
provide the statistical rigor needed to account for con-
textual factors and preexisting trends encountered in ITS
data [5]. The most utilized statistical methodology for
analyzing ITS data is segmented regression, a powerful
methodology accounting for underlying trends, including
outcome trajectories and correlation [6–8]. Segmented
regression was first introduced in [9], closely followed
by [10]. Since then, segmented regression has been used
in many forms and disciplines, including health services
research, economics, and education.
Traditional segmented regression a priori assumes the

change-point to be a specific value, typically at or around
the formal intervention, to fully differentiate the pre-
and post-intervention phases [11]. The change-point is
defined as the time point at which a change occurs in
the time series, i.e., the first time point in the post-
intervention phase [8]. A change in the time series is
not limited to a difference in the mean level. Changes
in the time series may be a change in the mean func-
tion (e.g., slope), a difference in the variance or spread
around the mean function, or a change in the time series
data’s autocorrelation structure. An intervention inter-
ested in increasing the stability and predictability of an
outcome may not lead to a change in the time series mean
level but may have decreased outcome variability and
increased autocorrelation. Decreasing outcome variability
leads to less extreme values while increasing autocorrela-
tion leads to a more predictable outcome. When assessing
the impact of an intervention, differences in variability
and autocorrelation are therefore important to capture
alongside mean differences. Our proposed RITS and R-
MITS approaches capture all of the aforementioned time
series’ changes.

An instantaneous intervention effect is often assumed,
i.e., the change-point is often set to the intervention time.
Specification of the change-point as the time of interven-
tion does not, however, represent the reality that complex
interventions may have varied effects and take time to
manifest change, and can therefore lead to incorrect mea-
sures of the intervention’s effect. Prevalent approaches to
overcoming this limitation are to remove a specific set
of time points from the analysis [7, 11]. This censoring
(i.e., removal of time points) not only omits data, but also
potentially biases parameter estimates, as the study team
decides which time points to remove. Segmented regres-
sion methods, furthermore, neglect plausible changes in
temporal dependence and variability post-intervention
and restrict the analysis to a single unit. These are serious
limitations because these methods ignore interpretable
changes in the higher-order moments of the response
and do not take advantage of all available data that may
provide information on the intervention’s effect.
The public health community has adopted two mea-

sures to assess the impact of an intervention: level change
and trend change. It is necessary to report both level
change and trend change when interpreting the results
of an ITS study [12]. Level change is interpreted as the
discontinuity between the projected mean (based on the
pre-change-point phase) and the estimated mean post-
change-point, i.e., the anchored intercept at the change-
point, depicted graphically in Fig. 1. Trend change quan-
tifies the impact of the intervention on the overall tra-
jectory of the mean function, i.e., the change in slopes
post-intervention.
The ‘Robust-ITS’ model proposed in [13] is based on

segmented regression and addresses two of the aforemen-
tioned limitations by estimating from the data — rather
than merely specifying a priori — the change-point and

Fig. 1 An example of an estimated mean function for sample data.
Depicts: (1) the estimated mean function for the pre- and
post-change-point phases, (2) the projection of the mean function at
the change-point based on the pre-change-point regression, and (3)
the change in level
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allowing for changes in an outcome’s mean function and
correlation structure post-intervention. Robust-ITS pro-
vides estimates of the level change and trend change, as
well as changes in the adjacent correlation (correlation
between two consecutive time points) and variance of the
response. Thus, using Robust-ITS allows researchers to
estimate (rather than merely assume) the lagged effect of
a health care intervention on a health outcome. Moreover,
researchers can determine whether health outcomes are
more predictable — stronger temporal dependence and
smaller variability suggests a more predictable, and thus
more desirable outcome — post-intervention.
[14] propose the ‘Robust Multiple ITS’ (R-MITS) model,

an extension of Robust-ITS for multi-unit data (e.g., mul-
tiple ITS of the same outcome for different units, health
systems, clusters, etc.), and the ‘supremum Wald test’
(SWT). The SWT is a formal test used to determine the
existence of a change-point over a set of possible change-
points specified by the intervention experts. R-MITS
borrows information across hospital units to increase effi-
ciency, estimates a global over-all units change-point, and
also allows for changes in the mean functions, temporal
dependence, and variability of an outcome across units.
This paper focuses on enabling the implementation

of Robust-ITS, R-MITS, and the SWT in the Robust
Interrupted Time Series (RITS) toolbox, a stand-alone
user-friendly, open-source and cross-platform application
freely available to the community. The RITS Toolbox
has been implemented using web technologies to ensure
smooth and uniform execution across platforms. The
user interface has been developed in JavaScript language
programming, while the statistical model has been inde-
pendently implemented in Nim language programming to
ensure better memory and speed efficiency. The source
code is maintained in a public GitHub repository [15].
Updated links for downloading the toolbox are included
in the repository.

Overview of methods
The RITS toolbox implements (i.) Robust-ITS for a sin-
gle ITS, (ii.) R-MITS for multiple ITS, and (iii.) the SWT
to test for the existence of a change-point in the mean
function(s) over a set of user-specified plausible change-
points. The Robust-ITS and R-MITS models differ in
expression solely through their capability to handle sin-
gle or multiple ITS; we, therefore, follow the notation for
R-MITS [14]. Let N denote the number of ITS or units.
If N = 1, then RITS implements the Robust-ITS model,
otherwise, R-MITS is implemented.
As in [13] and [14], we make a clear distinction between

the time of intervention and the change-point. The time
point at which the intervention is formally introduced is
denoted by t∗ and the change-point by τ . It may be true
that t∗ = τ , but this need not always be the case. For

example, an intervention learning effect may exist, leading
to a delay in the realization of the full intervention impact.
Conversely, there could be an anticipatory effect if there
is a period between announcement of the intervention
and its implementation during which some intervention
changes are slowly introduced [16].
Let yit denote the outcome of interest for unit i at time

t, with i ∈ {1, . . . ,N}, t ∈ {1, . . . , ni}, and ni denoting the
time series length for unit i. Then, the general regression
is defined as

yit = μit + εit , (1)

where μit is the mean function and εit is the stochastic
process that models fluctuations around the mean func-
tions and auto-correlation within the time series. The
mean function of the outcome of interest for unit i at time
t is

μit =
{

βτ
i0 + βτ

i1 t, t < τ(
βτ
i0 + δτ

i
) + (

βτ
i1 + �τ

i
)
t, t ≥ τ

, (2)

where βτ
i0 denotes the intercept of themean function prior

to the change-point, βτ
i1 denotes the slope of the outcome

prior to the change-point, βτ
i0 + δτ

i is the intercept of the
post-intervention phase, βτ

i1 + �τ
i is the slope of the post-

intervention phase for the outcome in unit i, and τ denotes
the global over-all-unit change-point of the response. In
the case with only one unit, τ denotes the change-point
for that one time series. If δτ

i = �τ
i = 0, then there is no

change in the mean function of unit i before and after τ .
Recall, the two metrics that are most commonly

reported in ITS studies are level change and trend change
[12]. Level change is denoted by δτ

i +�τ
i τ and interpreted

as the change in anchored intercept (anchored at the
change-point); see Fig. 1 for visualization. Trend change is
the change in slope and thus denoted by �τ

i in Eq. (2).
The RITS toolbox allows the correlation structure to

be modeled with an independent, exchangeable, or AR(1)
correlation structure (default). In all cases the correlation
structure is assumed to vary pre- and post-change-point.
For simplicity we include the model specification for the
AR(1) case only, as that is the default and original cor-
relation structure assumed in both the Robust-ITS and
R-MITSmodels. Assuming an AR(1) process to model the
correlation structure via the residuals, RITS conditions on
the first observation, yi1 for all i. Let rit = yit − μ̂it denote
the residuals, with i ∈ {1, . . . ,N}, t ∈ {2, . . . , ni}, and μ̂it as
an estimate of the mean function for unit i at time t. The
residuals are modeled as:

rit =
{

φi1(τ ) ri,t−1 + eit,1, 1 < t ≤ τ̂ − 1
φi2(τ ) ri,t−1 + eit,2 τ̂ − 1 < t ≤ n. , (3)

with φi1(τ ) and φi2(τ ) in the interval (−1, 1) for all i, as
they are correlations. Specifically, φi1(τ ) is the correlation
between time point t and t+ 1 where t and t+ 1 belong to
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the pre-change-point phase and φ
|h|
i1 (τ ) is the correlation

between two time points h units away, say t and t+h, both
in the pre-change-point phase. The auto-regressive coeffi-
cient of the post-change-point phase, φi2(τ ), has a similar
interpretation. Note, eit,j

iid∼ N
(
0, σ 2

iw,j

)
for i ∈ {1, 2}, and

thus, the variance of the response at any time point t is

σ 2
it = σ 2

iw,j
1−φij(τ )2

for j ∈ {1, 2}.

Parameter estimation
The mean function parameters are estimated simultane-
ously with the stochastic component parameters and the
change-point. First, the set of potential change-points is
established by the application experts. Then, for each pos-
sible change-point, the generalized least squares estimates
of themean function parameters are obtained, followed by
the method of moments estimates of the stochastic com-
ponent parameters, via an iteratively re-weighted least
squares algorithm (IRLS). For further details about the
estimation procedure refer to [13] and [14].
The estimated change-point corresponds to the time

point in the set of possible change-points that maximizes
the conditional likelihood. The final estimates of the mean
function and correlation parameters are obtained by the
IRWLS algorithm at the estimated change-point.

Formal test for the existence of a change-point
RITS implements the supremum Wald test (SWT), a test
for the existence of a change-point in the outcome mean
functions [14]. The supremum Wald test calculates a
multivariate Wald test statistic for every possible change-
point and applies the Benjamini-Hochberg method to
adjust for multiplicity. If any of the multivariate Wald
statistics provide significant results when compared to the
Benjamini-Hochberg corrected critical values, the SWT
concludes that a change-point exists for at least one of the
units. The SWT results in a binary decision of whether or
not a change-point exists in any of the unit-specific mean
functions.
The SWT focuses on determining the existence of a

change-point across the unit specific mean functions, i.e.,
for each q ∈ Q, where Q denotes the set of possible
change-points, the SWT tests

H0 :

⎡
⎢⎢⎢⎢⎢⎣

δ1
�1
...

δN
�N

⎤
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⎡
⎢⎢⎢⎢⎢⎣

0
0
...
0
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⎤
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Let �β1 ≡ [
β1
1,0 β1

1,1 δ1 �1 . . . β1
N ,0 β1

N ,1 δN �N
]′

be
the vector of mean function parameters under the
alternative hypothesis (with 4 × N elements), �β0 ≡[
β0
1,0 β0

1,1 . . . β0
N ,0 β0

N ,1
]′
be the vector of mean function

parameter estimates under the null hypothesis (with 2×N
elements), and C denote the contrast matrix that selects
the δi and �i entries for all i from �β1. The above hypothe-
ses can then be simply rewritten as

H0 : C �β1 = �0 vs. Ha : C �β1 �= �0.

The multivariate Wald test statistic is therefore

W =
(
C �̂β1

)′ [
C V̂( �̂β0

)C
′
]−1 (

C �̂β1
) H0.∼ χ2

2N , (4)

with V̂
(

�̂β0
)

denoting the estimator of the variance

covariance matrix of �̂β0
, the estimator of �β0. Note,

V̂
(

�̂β0
)
is block diagonal (with each block corresponding

to one unit) because we assume that the units are inde-
pendent. The multivariate Wald statistic is calculated for
each q ∈ Q. If any of the multivariate Wald tests pro-
vide significant results when compared to the Benjamini-
Hochberg corrected critical values, the SWT concludes
that a change-point exists for at least one of the units over
the set of possible change-points.

Implementation
The RITS toolbox is a cross-platform open-source pro-
gram developed using web technologies to assess the
impact of interventions using two statistical models: the
Robust-ITS and R-MITS models for single- and multi-
unit data. The user interface aims to smoothly interact
with data while prioritizing interpretability via a high-level
abstraction of the statistical model and internal computa-
tional details.
The toolbox is designed with an architecture based

on classes and components organized in logical pack-
ages grouped into two subsystems: the modeling and the
graphical user interface subsystem – each one written in
a different language and under distinct sets of dependent
libraries.
The user interface is delivered using hybrid web-desktop

technologies with integration between user-friendly mod-
ern features from web widgets and native operating sys-
tem (OS) services. The communication with the user’s
OS is achieved using the Electron framework. This tech-
nical choice enables the program to be executed across
platforms consistently without the need to install any
additional software. Note that the proper functionality of
the main features is evaluated on three major operating
systems: MacOS, Windows, and GNU/Linux.
RITS toolbox’s users can manage potentially sensitive

information. We, therefore, evaluate and examine the
libraries involved in the program to ensure that the frame-
work will operate fully offline. There is full control over
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the data used inside the software (web-based libraries do
not always meet with this requirement).
Compared to the user interfaces, the RITS’ statistical

models have a different set of computational require-
ments, including a higher degree of numerical accuracy,
better memory management and time efficiency. In order
to meet these requirements, we implement the subsys-
tem in a different programming environment that can
support the specifications. The source code is written in
the Nim language programming using an object-oriented
programming (OOP) paradigm.
The statistical modeling subsystem is written in the

Nim programming language with a collection of OS-
independent libraries that allow this software component
to be embedded as a standalone library in C appli-
cations or included in web applications written in JS.
Both back-ends are provided by the programming lan-
guage, which ensures the inter-compatibility of the appli-
cation with potential extensions. The vast majority of the
source code in this subsystem is written as an object-
oriented paradigm (OOP) for extensibility and debug-
ging purposes. The OOP style enables the integration
of future models in the RITS toolbox. In addition, the
chosen programming framework provides a robust type
system that encourages the consistency of input data at
compile-time without memory and time overhead. The
source code written with this language is later compiled
into a highly optimized JavaScript (JS) that is later cou-
pled into the user interface. The model’s code is highly
optimized to ensure the overall efficiency of the RITS
software.
The user interface (UI) subsystem is mainly written in

plain JS, based on web components (also named cus-
tom elements in the W3C specification of HTML5.3
[17]). RITS toolbox depends in several libraries includ-
ing Riot.js (component management), Dygraph (visual-
ization), domtoimage (visualization), htmlDocx (report-
ing), and moment.js (time data parsing). Secure access
and manipulation of local files is provided by the Elec-
tron framework which encapsulates the web application
into a desktop executable using the core functions of the
Chromium rendering engine.
Moreover, the UI subsystem is completely written into

a component-oriented programming (COP) framework.
This programming methodology is standard for user
interfaces and ensures some of the main OOP’s features,
such as encapsulation, but it prioritizes composition over
the inheritance as prevalent mechanism for reusing pieces
of code.
Given the complexity and the need for the user inter-

faces’ extensibility, the UI subsystem is grouped into five
packages according to their core functionality: data source
management, layout, summary panels, report panels, and
visualization components. Figure 2 displays a simplified

class diagram of the toolbox, where the association
between the different packages and subsystems is high-
lighted. The final graphical interface that the user navi-
gates in the toolbox, shown in Fig. 3, consists of multi-
ple modules from different packages that are seamlessly
combined.
The elements specified in the layout controller

package describe the application’s logical structure:
menus, panels, and wide-system events. The process-
ing of input data is abstracted through several classes
within the data source package. The presentation
of information is carried out in two modes (overall or
detailed/comprehensive), and it is managed by a) the
summary package that handles the components that
expose a limited, yet succinct, information of each ITS
through tables and figures; and b) the report package
that includes the components that display a comprehen-
sive list of tables or figures with all relevant results. The
main difference between the previous packages consists
of the report components’ ability to render and export its
contents to document formats, such as DOCX file for-
mats. It should be noted that the management of every
figure in the software is handled by one component in
the visualization package; and that every single plot-
ted graph includes some visualization interactivity, image
exporting functions (in PNG or DOCX formats), and
updating routines that are optimized to avoid overhead in
memory or speed performance.

Discussion
User interface
The RITS toolbox has a visual structure organized
through the main menu and several panels. The menu
contains four tabs: Data, Plots, Reports, and Help
which centralize the access to any of the panels assigned
to the primary tasks: obtain estimations, generate reports,
or adjust the model’s specifications. The function of each
panel is described below.

Button data > load
This button loads a dataset into memory. Currently,
the software allows comma- or tab-separated file for-
mats as input, CSV or TSV, respectively. Those files
are read and transformed into instances of the class
ModelDataSource in memory.

Panel date > date settings
In real conditions, the user could focus the analysis on
a fragment of the full dataset closer to the formal pol-
icy intervention. This could turn into more pertinent for
voluminous records. This filtering by date range can be
achieved in this panel. There is an interactive graph with
a smaller range selector at the bottom for picking the date
intervals to focus. Only the visible part of the time series
will be processed.
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Fig. 2 Abbreviated class diagram of the RITS toolbox with their respective subsystems: a) statistical model and b) user interface. Component
packages part of the user interface subsystem are also marked with blue dotted boxes: b.1) layout controllers, b.2) data sources’ management, b.3)
summary panels’ controllers, b.4) report panels’ controllers, and b.5) visualization components

Every update on these parameters will be applied only
after clicking the button Run the model at the bottom
of the screen. Note also that the settings can be changed
at any moment.

Panel date > change-point candidates
Robust-ITS and R-MITS require determining a collection
of change-point candidates through the interval
{t∗ − m, . . . , t∗, . . . , t∗ + k}, where m and k are positive
integers. In the RITS toolbox, the user can determine
this set of possible change-points using the date range

selector at the bottom of this panel. Consider that the
change-point candidate τ is assumed to be in the middle
of the chosen range. Once the interval has been defined,
click on Run the model to update the model.

Panel view > summary

This panel provides a summarized perspective of the the-
oretical and estimated change-points for each unit. Note
that this panel is automatically opened after performing
any update in the model settings.
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Fig. 3 Overall user interface (a) of the RITS toolbox along with the menu options distributed in four main tabs: b) Data, c) Plots, d) Reports, and e)
Help with their respective buttons

There are two subpanels in this layout. The upper
panel, summary data, exhibits a table that highlights
the impact (or changes) on estimates of the model (inter-
cept, slope, and noise) as a result of the change-point at
every unit. In general, this view gives a brief perspective
on the strength of a particular policy.
The second subpanel, relevant results, break-

downs the information of the previous table for each unit.
A graph contrasts the estimated change-point against the
formal intervention point. The table makes explicit the
estimated change-point, and the parameters’ values, dif-
ferences and confidence intervals before and after the
change-point.

Panel view > original series
The time series displayed in the dataset can be examined
in this table. Each chart is grouped according to its unit
(which can be accessed from the list on the left side).

Panel view > estimatedmodel
This panel shows the original time series and the esti-
mated mean functions displayed simultaneously orga-
nized by units. The likelihood associated with each
change-point candidate is also plotted. Note that each

graphic allows various interactive display actions: zoom
in, zoom out, on-hover legend, and export the chart.

Panel view > residuals
To allow a visual inspection of the quality of the fitted
model, this panel shows the residuals of the model. Three
visual components are displayed per unit: the residuals
over time (for a visual inspection of heteroscedasticity),
box plots, and the autocorrelation function. All compo-
nents are separated for comparing pre- and post-change-
point.

Panel report > complete report
The report panel carries the essential function of present-
ing a full tabular and graphical description of the study on
the target dataset.
To properly evaluate the presence of a change-point,

the first table displays the results of applying a supre-
mum Wald test, as it is described in the SWT section.
Benjamini-Hochberg adjusted p-values (and critical val-
ues) are also reported in these tables. According to those
estimates’ uncertainty levels, the units’ time series are
labeled as with “effective change-point” (when the p-
values are lower than 0.05) or “no change-point”.
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In a second and third table, the estimates of the inter-
cept and slopes pre- and post-estimated change-points are
exposed. In each table, the estimates, p-values and 95%
confidence intervals are detailed.
Finally, the report also includes a set of graphs asso-

ciated to the fitted models of every unit: the estimated
mean functions, time plots of the residuals and their
autocorrelation function.

Button report > DOCX report
The comprehensive report of the analysis can be exported
through this button into a Microsoft Word 2017 XML
(DOCX) file format. Any word processor capable of pars-
ing MHT embedded in DOCX files can adequately render
the generated report. Note that it could take a few seconds
to load during the first time this button is pressed due to
the large number of graphs.

Panel help >model description
The preprint of [13] and [14], enclosing the technical
description of the models, are embedded in the software
for more in-depth information about Robust ITS and
R-MITS.

Illustrative example
Alongside the toolbox, we provide four different
sets of sample data. Here we present an analysis
sample_4.csv to illustrate the decisions users will
have to make, as well as the results produced by RITS.
The dataset used here provides generated data at the
month level for 4 different institutes during a time period
of about 7 years. This sample data is loosely based on
patient-centered ITS data collected around the imple-
mentation of Clinical Nurse Leader (CNL) integrated care
delivery, a nursing model that embeds a master prepared
nurse into the front lines of care [18]. The outcome is
based on aggregated (summed) patient experience scores
generated bi-weekly between January 1, 2010 and May
24, 2017. For the purposes of illustrating the toolbox, we
refer to the outcome simply by ‘outcome’ in this section.
Prior to showing any toolbox images or results of our

sample data, we provide a general guide on how to use
the toolbox. The standard execution workflow inside the
toolbox is:

1 Initially, download the sample CSV-formatted
dataset from the toolbox homepage [19] to reproduce
the results of the current section or skip to step 2.

2 Start the RITS toolbox: A data and privacy policy
disclaimer is shown automatically (Fig. 4.A). Select
Accept if you adhere to these terms and proceed with
the use of the toolbox.

3 Load the data: Click on the Data > Load button
and select the dataset that will be used for the
analyses(Fig. 4.B). If using one of the sample datasets

we provide, upload the data directly/. If using your
own data ensure that the data is in the correct format
- refer to our sample data for the correct format.
(Fig. 4.B).

4 Define model settings: Specify the interval of dates
to be included in the analysis using the date-range
selector (Fig. 4.C). Also, choose the potential
change-point and formal intervention time point
candidates (Fig. 4.D). Choose the appropriate
correlation structure: AR(1), exchangeable or
independent. Click on Run the model when both
date ranges and the theoretical (or formal
intervention) time point have been selected.

5 Model summary: RITS will automatically switch to
a new view with the summary data panel (Fig. 4.E)
and the relevant results panel (Fig. 4.F).

6 Visual examination: Click on View > Original
series to check the raw time series (Fig. 5.A) or
View > Estimated model to inspect the fitted
mean functions overlaid with time series (Fig. 5.B).
The pre- and post-estimated change-point residuals
can be assessed in the residuals panel, View >
Residuals, (Fig. 5.C, .D)

7 Report review: Click on Reports > Complete
report to access a comprehensive review of the
results of the analysis (Fig. 5.E). Note that the first
table contains the supremumWald test. In addition,
as mentioned before, this report can be exported to a
DOCX by clicking on the button Reports >
DOCX report (Fig. 5.F).

We followed steps 1-3 by downloading the data from the
toolbox website, accepted the data and privacy disclaimer,
and uploaded sample_4.csv. After uploading the data,
RITS provides two plots: a plot of the time series (Fig. 6)
and a plot of the set of possible change-points(Fig. 7). At
first both plots span the same time period, but the user
can adjust both plots as they see fit.
Figure 6 plots the time series outcome for the 4 health

institutes present in our sample dataset; this is the first
plot the toolbox produces. The user can choose the time
period to include in the analysis with the edges of the bot-
tom portion of this plot. We used the entire time period,
and as such, did not move the edges of the bottom portion
of the plot in Fig. 6.
The plot that allows the user to define the set of pos-

sible change-points and formal intervention time point
(“theoretical” change-point) is provided in Fig. 7 for our
specific example. We set the theoretical change-point to
October 17, 2012 and the set of possible change-points
to be all measurements between May 28, 2012 and April
18, 2013, for a total of 22 possible change-points. Note, if
your set of possible change-points starts between May 20,
2012 and June 4, 2012 and ends between March 31, 2013
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Fig. 4 Screenshots of the RITS toolbox (I): A) data and security policy, B) loading open data file, C) defining time period analysis, D) setting
change-point date candidates, E) data summary table, F) summary results per unit

and April 18, 2013, you will get the same results we obtain
in this example. This is because the measure dates occur
between the selected end-point dates and not exactly on
those chosen end-point dates. Figure 7 visually depicts
our chosen set of possible change-points and theoretical
change-point (the blue line at the top part of the figure).
We chose an AR(1) correlation structure in this setting.
We then clicked on Run the model and RITS

switched to a new view that provided the summary data
panel (Fig. 8) and relevant results panel (Fig. 9).
These two panels in Figs. 8 and 9 contain the bulk of

the results. Figure 8 shows the summary data panel for all
our example data and Fig. 9 includes the relevant results
panel for one health institute, Health Institute A. The
summary panel provides estimates of the change-point,
level change, trend change, and change in adjacent corre-
lation. From Fig. 9 we can see that for our sample data and
specified set of possible change-points, the change-point
is estimated to occur on April 30, 2013. The estimates
of level change, trend change, and adjacent correlation

change provided in Fig. 8 generally suggest that the policy
intervention lead to an immediate increase followed by a
gradual decrease in the outcome after the intervention.
Figure 10 provides the estimated mean function of

Health Institute A. From Fig. 10, we see that the outcome
seems to jump at the estimated change point and drops
slowly after that for Health Institute A.
We then followed step 6 to view the residuals of our

estimated model. The residuals, provided in Fig. 11 seem
well-behaved. These there is no evidence to indicate that
the model assumptions were violated.
Lastly, we followed step 7 to export our results to a

word document in which all the aforementioned plots and
tables are included.

Toolbox availability

The RITS toolbox, as described above, is an open-source
application available under the MIT/GPL dual license.
Use the git repository [15] to find the source code of
the application and their respective code documentation.
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Fig. 5 Screenshots of the RITS toolbox (II): A) raw time series plot, B) estimated model and change-point characteristics in the time series, C)
residuals time-series, D) residuals auto-correlation function, E) reports I: supremumWald test, F) reports II: intercept and slope changes pre- and
post-change-point

Compiled binaries can be obtained from the repository
page for the major operating systems (Mac OS, Windows
and GNU Linux) [19].

Existing software
The models implemented in the RITS toolbox are based
on segmented regression but allow for more flexibility
regarding the change-point and correlation structure. Var-
ious statistical packages and software exist for segmented
regression, not for the broader Robust-ITS and R-MITS
models or for a formal test for the existence of a change-
point. In SAS ETS, PROCmay be used to model the mean
function and stochastic process without a change-point,
therefore modeling time series data with no interruption
[20]. PROC ARIMA, also in SAS ETS, is able to model
ITS data solely with one overarching correlation structure
and a pre-specified change-point or the set of possible

change-points removed from the analyses [20]. Similarly
in STATA, ITS data can bemodeled assuming a single cor-
relation structure for the entire observational period and
with the change-point a priori specified or with the set
of possible change-points removed [6]. Using the package
segmentedR in R ITS data can be modeled with a fixed
number of discontinuities but without consideration of
the temporal correlation [21].
The models implemented in the RITS toolbox are based

on segmented regression but allow for more flexibility
regarding the change-point and correlation structure. Var-
ious statistical packages and software exist for segmented
regression, not for the broader Robust-ITS and R-MITS
models or for a formal test for the existence of a change-
point. In SAS ETS, PROCmay be used to model the mean
function and stochastic process without a change-point,
therefore modeling time series data with no interruption
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Fig. 6 Plots the time series for each unit (or health institutes) and
allows the user to select the time period of analyses. The first plot RITS
provides

[20]. PROC ARIMA, also in SAS ETS, is able to model
ITS data solely with one overarching correlation structure
and a pre-specified change-point or the set of possible
change-points removed from the analyses [20]. Similarly
in STATA, ITS data can bemodeled assuming a single cor-
relation structure for the entire observational period and
with the change-point a priori specified or with the set
of possible change-points removed [6]. Using the package
segmentedR in R ITS data can be modeled with a fixed
number of discontinuities but without consideration of
the temporal correlation [21].

Limitations of existing software
Existing software limit the type of ITS analyses that
researchers can conduct. Researchers are not able to
model changes in both the mean functions and correla-
tion structures, implement a test for the existence of a
change-point, and estimate a change-point (if estimation
is appropriate). Using existing software, researchers have
to choose whether to incorporate a change in the mean
functions or a change in the correlation structures. The
RITS toolbox is the first piece of software that tests for
the existence of a change-point, estimates the change-
point (if estimation is desired), and allows for changes in
both the mean functions and correlation structures at the
change point. Existing software requires the user to oper-
ate a statistical programming language (e.g., STATA, SAS,
and R), thus limiting user access to those with statisti-
cal programming experience. RITS does not require users
to know or learn any programming language. Instead,
RITS is an interactive toolbox that anyone without any
statistical programming experience can use.

Conclusion
The RITS toolbox models both single and multiple
ITS for continuous outcomes, allowing for unit-specific
mean functions and correlation structures, and estimating
(rather than assuming) a global over-all units change-
point. The mean functions and stochastic processes are
allowed to vary for each unit, thus providing unit-specific
estimates of the outcome’s level change, trend change, and

Fig. 7 Plots and allows the user to select the set of possible change-points as well as the formal intervention or change-point, denoted as
‘theoretical’ in the plot. This is the second plot RITS produces



Cruz et al. BMCMedical ResearchMethodology          (2021) 21:143 Page 12 of 15

Fig. 8 Estimates of the trend change, level change, and change in adjacent correlation for the example data

pre- and post-intervention adjacent correlations and vari-
ances. RITS allows independent, exchangeable, or AR(1)
correlation structures. See [13] or [14] for brief discus-
sions on how to choose the correct correlation structures.
We hope to incorporate more complex correlation struc-
tures, like an AR(p) with p>1 or an MA(q), into the RITS
toolbox as part of our future work. For guidance on how

the length of the time series and number of units impact
empirical power and type one error rates please see [14].
RITS estimates an over-all-units change-point when

multiple ITS are analyzed while allowing the mean func-
tions and correlation structures to vary by unit. The
change-point is estimated via a grid search over a pre-
determined set of possible change-points specified by the

Fig. 9 Estimates of model parameters for Health Institute A of our example data
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Fig. 10 Estimated change-point and mean function for Health Institute A of our example data

toolbox user. When specifying the set of possible change-
points, users must be cautious of competing intervention
effects. Users should aim to define the set of possible
change-points as the time points during which the inter-
vention of interest plausibly impacted the outcome and
exclude time periods affected by another intervention.
RITS implements a formal test for the existence of a
change-point over the set of possible change-points. Iden-
tification of a change-point relies upon the detection of a
change in either the mean level or slope of the response
post-intervention, across units.
RITS requires that the outcome is recorded at evenly-

spaced time intervals. The RITS toolbox allows for miss-
ing data by linearly interpolating missing values. This
imputation may lead to a small bias in parameter esti-
mates in comparison to other methods [22, 23].We there-
fore recommend against analyzing series with missing
data in RITS. In addition, RITS assumes that the time
series are recorded for the same time points across units
and analyzes data only for the overlapping time points.

For example, if one time series includes monthly mea-
sures between January and December 2015 and all other
units have monthly data from January 2015 to Decem-
ber 2016, only the 2015 data will be used. Evenly spaced
measurements are needed to estimate the assumed AR(1)
correlation structure properly, if assumed.
The methodology implemented in RITS assumes out-

comes are normally distributed, and as such, RITS does
not appropriately model discrete outcomes (e.g., does not
take the mean-variance relationship into account). We
plan on expanding the methodology and developing soft-
ware specifically for ITS analyses of discrete responses.
RITS does not allow for additional covariates (e.g., num-
ber of nurses in each unit, gender, etc.) at this time. We
hope to eventually build covariates into RITS in the future.
Researchers interested in adjusting for additional covari-
ates may now utilize and extend our code to do so in
their particular setting. Furthermore, when multiple time
series are analyzed, RITS assumes one global overall-units
change-point. This assumption may not be accurate in

Fig. 11 Residuals and autocorrelation function plots for Health Institute A of our example data
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practice, where different units may be affected by the
intervention at varying times. We will develop both meth-
ods and software for ITS data that allows for unit-specific
change-points.

Availability and requirements
• Project name: Robust Interrupted Time Series

Toolbox
• Project home page: https://biostatistics-kaust.

github.io/robust_time_series_toolbox/ [19]
• Operating system(s):Mac OSX, Windows (64 bits),

GNU/Linux
• Programming language: Nim programming

language using an object-oriented programming
paradigm and JavaScript

• Other requirements: No additional software
required

• License:MIT/GPL dual license
• Any restrictions to use by non-academics: None
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Robust Multiple Interrupted Time Series; SWT: SupremumWald Test; IRLS:
Iteratively Re-weighted Least Squares; OS: Operating System; OOP:
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